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WORKING WITH FORMS 

 Discussion 
You can insert forms to your Web pages. Forms allow you to obtain information from site visitors, such as 
feedback or product orders. 
 
Forms in a web are similar to forms you would complete on paper. You can design a form using the text 
boxes, check boxes, lists, and buttons available in FrontPage and then label them. Site visitors can complete 
the form and submit it; results can be saved to a file and used in databases or reports as desired. 
 
If your server does not have the FrontPage Server Extensions installed, you may not be able to test or use 
all of the available form features. The FrontPage Server Extensions are a set of programs installed on a 
Web server that support certain web creation and administration functions, such as including search forms 
in your web. If you do not have access to the FrontPage Server Extensions, you may be prompted to install 
the Microsoft Virtual Machine to preview some items, such as hover buttons. 

 
  

 
If you want to target a specific browser, thereby making certain features unavailable, you can do so by 
selecting the Tools menu and then selecting the Page Options command. On the Compatibility page, 
you can select the desired browser from the Browsers list, the version from the Browser versions list, 
and/or the server from the Servers list. You can also select and deselect the desired technologies under 
Technologies, as well as select or deselect the Enable with Microsoft FrontPage Server Extensions 
option. 

  

 
To categorize a page or file, right-click the page or file in the Folder List, select the Properties command, 
and then select the Workgroup tab. Select the desired categories and then select OK. 

  
 

CREATING A CUSTOM FORM 

 Discussion 
You can create a custom form to gather the desired information from site visitors. A FrontPage form works 
just like a form you would complete on paper, such as a product survey sent to you in the mail. It can 
consist of questions and choices for answers as well as text boxes the visitor completes. You can create 
surveys, orders forms, and customer information forms using the buttons, boxes, and lists available in 
FrontPage. You can create a custom form on a new or existing page. 

 
In order to create a custom form, it is a good idea to first identify the purpose of the form and decide what 
information you want visitors to provide, and then create the questions and choices accordingly. A form 
should have a specific purpose and be limited to only those questions that will provide you with essential 
information. 
 
When you insert a form, it appears as an area on your page surrounded by a dotted border. Within the 
border are two default buttons, Submit and Reset. The Submit button is what site visitors click to send the 
information they enter into a form. The Reset button allows site visitors to clear out the form data they 
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entered and start completing the form again. You can change the name of both buttons, as well as set their 
properties as desired. 

 Procedures 

1. Open the page in which you want to insert the form in Page view. 

2. Place the insertion point where you want to insert the form. 

3. Select the Insert menu. 

4. Point to the Form command. 

5. Select the Form command. 

6. Save the Web page. 

 

ADDING FIELDS TO A FORM 

 Discussion 
You can use forms to gather information from site visitors, such as product orders or survey responses. 
You can create and customize forms by adding form fields such as check boxes, radio buttons, and 
drop-down menus to gather such information. 
 
The Form submenu lists a variety of boxes, buttons, and menus. You can insert a One-Line Text Box 
when you want visitors to enter information, such as their first and last names. A Scrolling Text Box 
works like a one-line text box, except that this field allows site visitors to enter multiple lines of text. A 
Check Box or a Option Button allows site visitors to select from options you provide, such as order 
form items. The main difference between the two is that you can select multiple check boxes, but only 
one radio button in a group. A Drop-Down menu provides visitors with a list of options from which 
they can choose once they display the list. A Push Button allows users to submit information, reset a 
form, or complete any other activity tied to the button. 
 
When you insert the form fields, most are empty or unselected by default, while some may be selected. 
After inserting a form field, you can set its properties to define how you want it to appear on the form. 
 

  

 
If you want site visitors to be able to click the field or label text to make a selection, you can create the 
desired labels. To do this, select the form field and the label text, select the Insert menu, point to the Form 
command, and then select the Label command.  
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  Procedures 

1. Open the page in which you want to insert the form field in Page view. 

2. Create a new form, if necessary. 

3. Place the insertion point where you want to insert the form field. 

4. Select the Insert menu. 

5. Point to the Form command. 

6. Select the command for the desired field. 

7. Place the insertion point before or after the field to enter the text you want to appear with it. 

8. Type the text you want to appear along with the field. 

9. Place the insertion point where you want to create the next field. 

10. Press [Enter] or [Shift+Enter] to create the next line in the form. 

11. Continue to add the desired fields to the form. 

 

CHANGING FORM FIELD PROPERTIES 

 Discussion 
After inserting buttons, boxes, or menus, you can set the field properties to specify how you want the field 
to appear. You can indicate if you want the field to contain a value or be selected, by default. If you want 
the field to provide the visitor with choices, you will need to define the list of options. You can also set the 
width of the form as well as indicate a tab order. The tab order pertains to visitors pressing the [Tab] key to 
move around the form. By default, if a site visitor uses the [Tab] key, he/she can move from the top of the 
form to the bottom. If you prefer a different order, you can set the tab order for each field or field group. 

 
In addition to setting options for how the form will appear on the page, you also need to set options, such as 
a field name and value, for processing the form results. By default, form results are saved to a .txt file in 
your private folder; however, you can also save them to another file type as desired. 
 
When you set a field’s properties, the first thing you need to do is assign an internal name to the field. The 
internal name is usually a code or shortened version of the field label that enables you to quickly see the 
selection made by the site visitor or the information he/she entered. All fields, with the exception of radio 
buttons, require a different name for each field in the form. If you provide multiple radio buttons, only one 
in each group can be selected by the site visitor; therefore, all radio button fields are required to have the 
same group name. 
 
In addition to naming a field, you need to indicate the field’s value to be returned with the results. The 
value depends upon the type of field. 

 
The initial value for a text box is typically blank since this type of field is primarily used for data input. 
When you view the form results, the text box name will display along with the data input by the visitor. 
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The value for a check box is ON by default; you can change this as desired. When you view the form 
results, you will see the names of all check boxes listed. The boxes that were selected by the visitor appear 
with the text “ON” or other label you assigned. 
 
The value for each radio button must be unique; therefore, you need to assign each button a distinct value, 
representative of the choice. When you view the form results, the name of the radio button group will 
appear along with the value of the selected field. 
 
By default, the value for each option in a drop-down list is the same as the name of the choice; for example, 
the choice “Good” will be assigned the value “Good.” If desired, you can assign a different value to each 
choice. When you view the form results, the field name will appear with the value of the selected choice. 
 
The value for a push button is a letter and number by default, such as B1. You can change the value if 
desired, however, since submitting a form or resetting a form are typical push button functions and not 
results, this is not necessary. 

 
  

 
You can also set style properties for a field by selecting the Style button in the <field type> Properties 
dialog box. You can change the font formatting for the field text, add a border around the field, as well 
as apply a background color. 

  

 
You can also set form results to be sent to you or another recipient via e-mail.  

  
 

 Procedures 

1. Open the page in Page view containing the desired form. 

2. Add form fields to the form as desired. 

3. Right-click the field for which you want to set the properties. 

4. Select the Form Field Properties command. 

5. Enter the internal name for the field in the appropriate Name text box. 

6. If the field is a drop-down list, select Add, type the choice text, and select OK. Be sure to include “Please Select” 
as your first choice when creating a drop-down list. 

7. Continue to modify the properties for the currently selected field. 

8. Select OK. 

9. Continue to modify the properties for the remaining fields on the form.  
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DEFINING VALIDATION RULES 

 Discussion 
In addition to setting the names, values, and initial states for the fields on a form, you can also define validation 
rules for some field types. An example of a validation rule is requiring one radio button to be selected in order 
for the site visitor to submit the form. 
 
You can set validation rules for all fields with the exception of push buttons and check boxes. The rule settings 
vary for each field type. For example, while you can choose from a variety of settings for text boxes, there is 
only one setting for radio buttons. When you set a validation rule for one radio button, it applies to all buttons 
in the group. 
 
When you set a validation rule, you need to enter text in the Display name text box. The text you enter in this 
text box will appear when a site visitor tries to submit the form without complying with the validation rule. For 
example, if you made the “Name” field a required field, enter Name in the Display name text box. If a visitor 
does not type his/her name, they will get a warning when trying to submit their form that they forgot to 
complete the “Name” field. 

 

 Procedures 

1. Create a form and add the desired form fields. 

2. Double-click the field for which you want to set a validation rule.

3. Select Validate. 

4. Select the desired options to create the validation rule. 

5. Select OK after setting the desired validation rule. 

6. Select OK. 

 

SAVING A FORM TO A FILE/EMAIL ACCOUNT 

 Discussion 
You can save the form results to a file. By default, a .csv file in which to store the results is created and 
saved in the private folder in the current web (_private/form_results.csv). You can change the file into 
which to store the results and set file properties in the Form Properties dialog box.  
 
It is recommended that rather than use the default form_results.csv file, you create your own file to store 
the data in. This file should be a .txt file, not .csv, since .csv files automatically open in Excel and you want 
your file to open in Notepad. 
 
When you open the Form Properties dialog box, the Send to option is selected and the default 
form_results.csv file displays in the File name text box. You can change this option so that the results go 
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to your own form_results.txt file by selecting Browse (you must first create the form_results.txt file before 
browsing for it - more on that below). 
 
Once the file is identified, you can open the Options for Saving Results of Form dialog box and set options 
for the file results. You should select the format of the file as Text database using comma as a separator  
if you plan to import this file into Excel, Access or SPSS. You should choose to include the file names in 
your results and list the latest results at the end. You can also identify and set properties for a second file in 
which to store the results. A second file is helpful if you want to have a backup of your form results. 
 
You can also set form results to be sent to you or another recipient via e-mail account. When setting the 
“Options” for the email result, Formatted Text is the best format to use. DO NOT USE HTML AS THE 
FORMAT FOR THE EMAIL OR THE FORM WILL NOT WORK! 

  Procedures 

1. Create a form in your web. 

2. Click on the Folders button in FrontPage to get to the Folders view. Click once on your _private 
folder to open that folder.  

3. To create the form_results.txt file that will store your data, click the Web Site button in 
FrontPage to get to the Folders view of your website.  

4. Open the _private folder by double-clicking it. 

5. Create a new blank page using the New Page button on the right of the window.  

6. Type a name for the file, using csv as the file extension, such as survey_results.csv and hit Enter. 
You will get an error saying that the file may be unusable if you change the filename. Click Yes. 

7. If you need to rename the file after creating it, right-click on your new file and select Rename. 
Then give it the name survey_results.csv or whatever you want to call it. 

8. Open the “survey_results.csv” file and delete all of the HTML code in the file (click Edit, Select 
All and hit Delete). Save the file and close it. 

9. Now go back to your form by clicking on the Page view button on the left.  

10. Right-click anywhere inside of the form and select the Form Properties command. 

11. Click the Options button on the Form Properties window. The Saving Results window will 
appear. 

12. Click on the File Results tab, then click Browse and point it to the survey_results.csvt file that 
you created. Make sure the File Format is set to Text database using comma as a separator 
and that Include field names is checked. THIS IS IMPORTANT. THE FILE FORMAT 
MUST BE SET TO TEXT DATABASE USING COMMA AS A SEPARATOR. 

13. You can choose to save your form results into an optional second file, but you must also have 
created this file first. You can make an optional second file the same way that you made the first 
form_results.txt file. Or, if you want to be able to view this second file results on the web, give 
this second file an .htm extension (e.g., survey_results.htm) and set the file format set to HTML. 
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To have your form results sent to an email account, click on the Email Results tab and type 
the email address into the Email address to receive results: box. Select an E-mail format, 
with Formatted Text as the format. DO NOT USE HTML AS THE E-MAIL FORMAT 
OR THE FORM WILL NOT WORK! 

 
If you want the email message to have a specific subject line, type that subject in the 
Subject line: section.  

14. If you want to display a confirmation page to those submitting the form confirming that the form 
was successfully submitted, you must first create a confirmation webpage that says something to 
the effect of “Thank you for completing this form…”  

To do this, create a new webpage with your Thank You message and save the file as 
XYZ_thanks.htm, where XYZ is the name of your form. Then go back to the Form Properties 
box, click Options, and go to the Confirmation Page tab. Click Browse and point it to your 
XYZ_thanks.htm file. 

If you do not specify a confirmation page, the person submitting the form will receive a default 
confirmation page listing the field names and what they typed into each field on the form. 

15. Before exiting the Saving Options window, be sure to click on the last tab, which is the Saved 
Fields tab. All of the fields in your form should be listed in the Form fields to save: box. If they 
are not, click on the Save All button. The results from all of the fields in your form will now be 
saved to your form results file.  

If you see field names on the Form fields to save: list that do not have names, but rather say T1 
or D1, this means that you neglected to name one or more of your form fields. In this case, you 
must go back to the form, edit the form fields that are unnamed, then return to this list and click 
the Save All button again. The only exception to this is the Submit button (the last B1 field on 
the list), which can be removed from the Form fields to save: list altogether. 

To also record the date and time that each form was submitted, select a Date format and a Time 
format. Do not bother checking any of the three Additional information to save boxes, for this 
data will not help you in any way. 

16. Click OK to save your changes. 

 
 
 
 

IMPORTING FORM RESULTS INTO EXCEL OR ACCESS 

 Discussion 
 
If you have programmed your web form to save the results in a csv file, that file will open up in Excel by default. 
You can also import that file into an Access database. If you need to run queries on the data to count the number of 
people who answered a question one way as opposed to another, you should probably use Access.  
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 Procedures 

1. Open your website in FrontPage. 

2. Locate your survey_results.csv file (or whatever it is called - it should be in your _private folder) 
and double-click on it. The file will open in Notepad. 

3. In Notepad, click File and select Save As…” 

4. Save the file in a place where you can easily find it, either on the Desktop, in your My 
Documents folder. 

5. Once the file is saved, close FrontPage and open either Microsoft Excel or Microsoft Access. 

 
 

If opening the file in Excel 
1. Click the Open icon and change the Files of Type to Text Files (*.prn, *.txt, *.csv).  Locate the 

file and open it.  

2. Step 1 of 3 of the Text Import Wizard will open up. Select Delimited as the file type and leave 
everything else as it is. Click Next.  

3. On Step 2 of 3, you need to select the delimiters. Uncheck Tab and place a check in the Comma 
box. Then click Next. 

4. In Step 3 of 3, you can specify how you want Excel to format the columns. Click on each field 
and specify whether or not you want the cells formatted as General, Text, Date or if you want 
the field to be Skipped (Do not import column). 

Important Note: If you are importing a zip code field or any field where some of the data begins with 
a 0, such as a zip code of 08560, you must import that field as a Text field or you will lose the 0 or 
else you will lose the 0 in front of that field. 

5. When you are finished, click Finish. 

 
If opening in Access 
1. In Access, click File, New and from the taskpane on the right (Access 2003), click Blank 

Database. Give your blank database a name and file location and click Create. 

2. Once in your new blank database, click File, Get External Data, Import. 

3. Change the Files of type to Text Files (*.txt, *.csv, *.tab, *.asc). 

4. Locate your file and click Import. 

5. In the Import Text Wizard, choose Delimited as your file type and click Next. 

6. Make sure the delimiter is set to Comma and place a check in the box that says First Row 
Contains Field Names, as long as the first row of data in your text file is the field names. Leave 
the rest as is and click Next. 

7. Select In a New Table and click Next. 
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8. You now have a chance to change the field name, data type and indexed status (when a field is 
indexed in Access, any sorts or searches you do on that field will be faster; however, the more 
indexes you have, the slower your database will run, so limit the number of indexes if possible). 

Field names should not have spaces in them. 

Data type will depend on what kind of data is in the field. Most should suffice with Text set as 
the type, but if the data in that field is longer than 255 characters, you must change the type 
to Memo or you will lose data!!! Click Next when you are finished. 

9. Select whether or not you want Access to assign a primary key or not. You do not have to assign 
one now. Click Next. 

10. Type the name of your table or accept the default name that the program gives it and click 
Finish. 

11. You should get a message saying that Access is Finished Importing… If you get a long 
message saying that there were Import Errors, call the Helpdesk. 
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